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Snapple Real Fact # 717 
Mangoes are the most  

consumed fruit in the world. 
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Most small business (SMB) owners focus on 
the day‐to‐day operaƟons of their organiza‐
Ɵon, driving growth, facilitaƟng hiring and 
guiding markeƟng, without a single thought 
given to the security of the computer networks 
these processes depend on. AŌer all, they’re 
just the liƩle guy – why would hack‐
ers go to the trouble of penetraƟng 
their systems for the minuscule 
amount of data they store?
According to Verizon’s annual Data 
Breach InvesƟgaƟons Report, a full 71% of 
cyber‐aƩacks are aimed squarely at SMBs. But 
why? As Tina Manzer writes for EducaƟonal 
Dealer, “Size becomes less of an issue than the 
security network … while larger enterprises 
typically have more data to steal, small busi‐
nesses have less secure networks.” As a result, 
hackers can hook up automated strikes to liŌ 
data from thousands of small businesses at a 
Ɵme. 

It takes constant vigilance, and most of all, 
knowledge to keep your system secure today.  
Below are the four most common ways hackers 
infiltrate small businesses. 

1. PHISHING E‐MAILS
An employee receives an e‐mail directly from 
your company’s billing company, urging them 
to fill out some "required" informaƟon before 
their paycheck can be finalized. Included in the 
very professional‐looking e‐mail is a link your 

employee needs to click to complete 
the process. But when they click the 
link, a host of vicious malware floods 
their system, spreading to the enƟre‐
ty of your business network within 

seconds, and locks everyone out of their most 
precious data. In return, the hackers want 
thousands of dollars or they’ll delete every‐
thing. Today it’s easier than ever for an aƩack‐
er to gather key informaƟon and make a phish‐
ing e‐mail look exactly like every other run‐of‐
the‐mill e‐mail you receive each day. Train your 
employees to recognize these sneaky tacƟcs 
and put in safeguards in case someone  
accidentally clicks the malicious link. 

BAD PASSWORDS 
According to Inc.com contribuƟng editor, John 
Brandon, “with a $300 graphics card, a hacker 

(Continued on page 2) 

September 2018 

“As a business 
owner, you don’t 

have time to 
waste on 

technical and 
operational issues. 

That’s where we shine!  
Call us and put an end to your  

IT problems finally and forever!” 
Fred Holzsager,  

IT Director 
Holzsager Technology Services 

 and  
 Publisher of  

The Tech Insighter 

“Insightful Tips To Make Your Business Run Faster, Easier and Be More Profitable” 

“We Love Referrals” 2018 Offer 
Keeping with the spirit of helping others,  

if you refer a business to us and they become our customer, 
we will donate $100 to your favorite charity. 

At Holzsager Technology Services, we believe that referrals are the greatest form of flattery.  
By recommending your partners, associates, or professional contacts, you can help them  

enjoy worry-free IT and support a worthy cause of your choice! 

For more information, please see our website at  
www.tech4now.com/we-love-referrals, contact us by phone at 201-797-5050  

or email us at info@tech4now.com . 

The Tech Insighter 
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“We make all of your computer 
problems go away without the 

cost of a full-time I.T. staff” 

Ask us about our fixed price 
services HTS Insight  

Hassle-Free Agreements—
Computer Support at a flat 

monthly fee you can budget for 
just like rent! 
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“It always seems impossible un l 
it’s done.”  

   Nelson Mandela  

"Who looks outside, dreams; who 
looks inside, awakes." 

C. G. Jung

"You may delay, but me will not 
and lost me is never found 
again." 

  Benjamin Franklin 

"Go for it now. The future is 
promised to no one." 

   Wayne Dyer 

"It's hard not to feel happy when 
you make someone smile." 

     Roy T. BenneƩ 

"Don't cri cize what you can't 
understand." 

 Bob Dylan 

4 Ways Hackers Will AƩack Your Network 

A client called the other day to indicate he had 
received an e‐mail which showed an invoice for 
a MicrosoŌ Surface.  The invoice had details of 
the purchase, but the balance was outstanding 
and the name was missing.  This presented the 
recipient with a quesƟon:  Did someone order 
this using my credit card?  For your informaƟon, 
the leƩer was addressed “Dear Customer:” On 
the boƩom of the invoice was a noƟce that 
read:  If you received this message in error, 
please call 800‐XXX‐XXXX to let us know that 
you received it.  Inasmuch as you are unauthor‐
ized to receive this message, you will be  
expected to delete it.  Should this be your credit 
card and the invoice is incorrect, please call us 
at 800‐XXX‐XXXX and we will fix this maƩer. 

The client, concerned over the maƩer, called 
the number and was advised by the person on 
the other end that this was due to a “bad IP  
address.”  The other party then walked the  
recipient through the steps of loading a session 
of GoToAssist™ on his machine while the sup‐
port people “fixed” the IP issue.  They then 
prompted the respondent to provide his email 
and password to fix the maƩer.  It was during 
this call that we received a call for help asking, 
“What do I do now?” 

Too many people fall for this scam.  In the pro‐
cess, the e‐mail recipient appears to think that 

he/she is helping the shipping company to fix an 
issue with billing, but, in fact, the sender of the 
e‐mail only wants to gain elevated access to 
your machine to either collect info, infect a  
machine, sell a bogus support ‘contract’ or  
simply perpetuate their scam by launching it 
through your e‐mail account. 

Let us help you to avoid 
becoming a vicƟm.   

ConƟnue to read our FREE Security Tip e‐mails, 
sign up for online security training, PII Protect 
(see more informaƟon to the right) or consider 
reading a copy of our book on Cyber‐
crime (see more informaƟon to the 
leŌ).  All of them will help you raise 
your awareness of the threats that 
abound and make you more sensiƟve 
to the telltale signs that someone is 
trying to vicƟmize you via a computer, 
phone, or mail by using social engineering. 

It's easier to keep your computer clean if you 
never let scammers and thieves get on your 
machine in the first place. 

If you require assistance in avoiding this  
situaƟon for your business, please contact us at  
(201) 797‐5050 or info@tech4now.com for 
more informaƟon.  We are dedicated to your 
success (and data security)!

can run 420 billion simple, lowercase, eight‐ 
character password combinaƟons a minute.” 
What’s more, he says, “80% of cyber‐aƩacks 
involve weak passwords, “yet despite this fact, 
“55% of people use one password for all logins.” 
As a manager, you should be bothered by these 
staƟsƟcs. There’s simply no excuse for using an 
easy‐to‐crack password. It’s a good idea to make 
a password out of four random words, splicing 
in a few special characters for good measure. To 
check the strength of your password, type it into 
HowSecureIsMyPassword.net before you make 
it official. 

3. MALWARE
As described above, malware is oŌen delivered 
through a shady phishing e‐mail, but it’s not the 
only way it can wreak havoc on your system. An 
infected website (such as those you visit when 
you misspell sites like Facebook.com, a tech‐
nique called “typosquaƫng”), a USB drive load‐
ed with viruses or even an applicaƟon can bring 

vicious soŌware into your world without you 
even realizing it. In the past, an anƟvirus soŌ‐
ware was all that you needed. These days, it’s 
likely that you need a combinaƟon of soŌware 
systems to combat these threats.  

4. SOCIAL ENGINEERING
Social engineering differs from tradiƟonal hack‐
ing in that aƩacks can be non‐technical and 
don’t necessarily involve the exploitaƟon of 
soŌware or systems. When successful, many 
social engineering aƩacks enable hackers to gain 
legiƟmate, authorized access to confidenƟal 
informaƟon. It’s easier than you think, and  
requires carefully watching what informaƟon 
you put on the Internet – don’t put the answers 
to your security quesƟons out there for all to 
see. 

These are some of the simplest ways to defend 
yourself against these shady techniques, but the 
best way is to keep your system updated and 
monitored with the most cuƫng‐edge security. 
We can help with that—contact us today at 
(201) 797—5050 or www.tech4now.com.

(Continued from page 1)  

 If you would like to have us 
speak to your organization and 
give away some free copies to  
attendees, give us a call. For 

more details on the contents and 
how to get your own copy, please 

visit our special web page at 
www.tech4now.com/cybercrime 

A Scam That’s Also A Redirected AƩack 



 

2018©Holzsager Technology Services, LLC www.tech4now.com (201) 797-5050 

Trivial Matters 
True or false? Every click, 
every view and every sign‐up 
on the internet is recorded 
somewhere.  As you may 
have guessed, this is true and everyone’s worst 
nightmare.  Get ready– some of these social 
media staƟsƟcs may boggle your mind!  
For context, as of April 2018, total worldwide 
populaƟon was 7.6 billion. 

 The internet has 4.2 billion users. 

 There are 3.03 billion acƟve social media  
users. 

On average, people have 5.54 social media 
accounts. 

 Social media users grew by 121 million 
between Q2 2017 and Q3 2017 ‐ that’s a new 
user every 15 seconds! 

 US adults spend an average of 1 hour, 16 
minutes each day watching video on digital 

devices. 

 Google, responsible for 92% of all searches, 
processes 100 billion searches a month, which 
is 40,000 searches a second! 

 68% of all Americans are on Facebook and sƟll 
growing: Facebook adds 500,000 new users 
every day; 6 new profiles every second. 

With 500 million tweets sent each day (that’s 
40,000 a second) it took 3 years, 2 months 
and 1 day to go from the first Tweet to the 
billionth. 

 People now watch 1 billion hours of YouTube 
videos every day with more than half of the 
views coming from mobile devices. 

More than 40 billion photos have been shared 
so far on Instagram, with 95 million uploaded 
each day. 

It’s astounding to consider just how much the 
computer has ALSO affected our producƟvity! 
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MicrosoŌ Word Time‐Saving Tips 
While millions of people use Word every day, 
most don’t know how to maximize its potenƟal. 
And since it is constantly being updated, you 
need to check out these Ɵps that will help you 
save Ɵme. 

Edit Simultaneously 
You and your colleagues can now edit the same 
Word document at the same Ɵme. Just save 
yours in the cloud on OneDrive, click Share, then 
send the link to your colleagues. You’ll even be 
able to see them ediƟng in real Ɵme. 

ConƟnue Your Work with Word Online 
Don’t have the Word app on your computer, 
tablet, or smartphone? Go 
to word.office.com, sign in with 
your MicrosoŌ account, and 
open Word Online, the browser 
version of Word. By clicking the 
blue Share buƩon, your col‐
leagues can access your document using Word 
Online or the Word app, which means anyone 
with the link and an internet connecƟon can 
jump right in. 

Keep Editorial Control 
With the Track Changes funcƟon, Word moni‐
tors all the edits that everyone makes to your 
document so you can go through the changes 
and accept or reject them accordingly. To turn 
on Track Changes, click on the Review tab then 
select Track Changes. When reviewing a col‐
league’s edits, you have control to click 
on Accept or Reject as you see fit. 

Format the Easy Way: Write First, Format Later 
The Style Gallery in Word makes it easy to  
format your document, despite the huge  
number of font types, sizes, colors, and effects 
to choose from. AŌer finishing wriƟng and  
ediƟng your document, click the Home tab and 
you will see the Style Gallery prominently on 
top. Select the appropriate Headings in the font, 
size, and color that you like, and change any 
other text in any way you like. 

Insert Photos Faster, More Conveniently 
No need to open your browser to look for  
photos for your document. Just place the cursor 
on the area where you intend to insert the  
photo, click on the Insert tab, select Online  
pictures (type “clip art” on the search box if 
that’s what you need), select a photo, then 
click Insert. 

Edit a PDF File 
Click on the File menu, select Open, and 
choose Browse. Highlight the PDF you want to 
edit, then click Open. Word will convert files to 
the new format using text recogniƟon, be sure 
to double‐check if the conversion is correct. 
Make the appropriate changes, then click File, 
then Save As, then Browse. A “Save as type:” 
dropdown menu will appear at which point you 
will choose “PDF” then click Save.  Be warned, 
this won’t work on a ‘secure’ or ‘locked’ PDF. 

Want to learn more Word tricks and Ɵps? Get in 
touch with our MicrosoŌ Office experts today at 
(201) 797—5050 or www.tech4now.com! 

Quick Tech Productivity Pointers 

Are You Protected 
From A Data Breach? 

 

Think cybercriminals 
only target the big 
companies? 
 

More than 75% of 
data breaches tar-
get small and medi-
um sized businesses. 
 

 
We can help you with the following: 

1.TRAIN YOUR EMPLOYEES 
Train your employees to help  
protect your sensitive data. 
2. PROTECT YOUR NETWORK 
Protect your network with 
VPN’s, firewalls, vulnerability 
scans, penetration testing, etc. 
3. SECURE YOUR DEVICES 
Identify, track, and secure 
(encrypt) your employee’s de-
vices—smartphones, USB 
drives, tablets and laptops. 
4. SECURE PHYSICAL SPACE 
Track and log visitors, limit 
access with locked doors. 
5. CREATE CLEAR POLICIES 
Create clear and concise  
written policies on the use and  
disposal of sensitive data. 
6. WHERE’S YOUR DATA? 
Locate, understand, and limit 
where all of your sensitive data 
resides. 
7. PROPER DISPOSAL  
   PROCEDURES 
Ensure that you have the prop-
er procedures and documents in 
place to dispose of any devices, 
equipment, and paper records. 

LET US HELP YOU PROTECT 
YOUR BUSINESS AND DATA. 

CONDUCT A  
SECURITY RISK ASSESSMENT  

TO UNDERSTAND  
YOUR RISKS. 

CONDUCT A  
DARK WEB ASSESSMENT 

TO SEE IF YOUR PASSWORDS 
MAY HAVE BEEN  
COMPROMISED 

Contact us at  
(201) 797–5050 or 

www.tech4now.com/pii‐protect 
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Services We Offer: 
Hassle-Free IT powered by HTS Insight Managed Services 
General Network Repair and Troubleshooting 
Onsite and Offsite Backup 
Disaster Recovery and Planning 
Virus Protection & Removal 
Network Security and Online Employee Security Training 
Mobile and Hosted “Cloud” Computing 
E-mail & Internet Solutions 
Wireless Networking 
Spam Filtering and E-mail Archiving Solutions 
Storage Solutions and File Sharing 
System Audits and Network Documentation 
Voice over IP phone systems 
 

“We make all of your computer problems go away without the 
cost of a full-time I.T. staff” 
Ask us about our fixed price service agreements—Computer support at a 
flat monthly fee you can budget for just like rent! 

Like Brother, Like Brother 
There were three brothers‐one 96, one 94 and 
one 92 years old. One night the 96 year old draws 
a bath, puts his foot in and pauses. He yells down 
the stairs, "Was I geƫng in or out of the bath?" 
The 94 year old yells back, "I don't know, I'll 
come up and see." He starts up the stairs and 
pauses, then he yells, "Was I going up the stairs 
or coming down?" The 92 year old was siƫng at 
the kitchen table having coffee listening to his 
brothers. He shakes his head and says, "I sure 
hope I never get that forgeƞul." He knocks on 
wood for good luck. He then yells, "I'll come up 
and help both of you as soon as I see who's at the 
door." 
 

The DNA Test 
AŌer 3 years, a wife starts to think that their 
child looks different, so she decides to do a DNA 
test. She finds out that the child is actually from 
completely different parents. 
Wife: "Honey, I have something very 
serious to tell you." 
Husband: "What's wrong?" 
Wife: "According to DNA test results, 
this is not our child." 
Husband: "Well don't you remember? When we 
were leaving the hospital, we noƟced that our 
baby had a wet diaper and you said, 'Honey, go 
change the baby, I'll wait for you here'." 

Back to School 
What does homework stand for? 
Half of my energy wasted on random knowledge. 
 

Score One for Man’s Best Friend 
A lost dog strays into a jungle. A lion sees this from 
a distance and says with cauƟon "this guy looks 
edible, never seen his kind before". So the lion 
starts rushing towards the dog 
with menace. The dog noƟces 
and starts to panic but as he's 
about to run he sees some 
bones next to him and gets an 
idea and says loudly 
"mmm...that was some good 
lion meat!". The lion abruptly stops and says " 
woah! This guy seems tougher then he looks, I 
beƩer leave while I can". 
Over by the tree top, a monkey witnessed every‐
thing. Evidently, the monkey realizes the he can 
benefit from this situaƟon by telling the lion and 
geƫng something in return. So the monkey  
proceeds to tell the lion what really happened and 
the lion says angrily "get on my back, we'll get him  
together". 
So they start rushing back to the dog. The dog sees 
them and realized what happened and starts to 
panic even more. He then gets another idea and 
shouts "where the heck is that monkey?! I told him 
to bring me another lion an hour ago..." 

The Lighter Side... 

IT Solutions for  
YOUR Business! 

Phone: (201)797-5050 
E-mail: support@tech4now.com 

Holzsager Technology Services, LLC 
P.O. Box 535 

Fair Lawn, NJ  07410-0535 

“Your breadth of experience and speed to resolution helps us keep our business strong and  
current. The way we see you is not as an IT computer guy, but as a proven Trusted Business  
Advisor.” —Nabil Ishac, Architect & Owner, Ishac Design Architect 
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(201) 797-5050 
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Feedback & Suggestions… 
 

Is there a topic or feature you 
would like to include in a future 
issue?  Opinions and feedback are 
welcome and encouraged. Please 
send us an e-mail or call our direct 
line. 
 

E-mail: info@tech4now.com 
Phone: (201) 797-5050 

5 Reasons To Choose A 
Hosted VoIP Phone System 

 

1. COST SAVINGS  
2. ANSWER CALLS ANYWHERE  
3. ON‐DEMAND SCALABILITY  
4. WORLD‐CLASS FEATURES  
5. ENHANCED PRODUCTIVITY  
 
As a small business, you need every 
advantage to be as efficient and 
producƟve as possible. Holzsager 
Technology Services is proud to 
provide our clients with a cost‐
effecƟve, feature‐rich, world‐class 
phone system that is easy to use 
and sure to enhance your business 
producƟvity.  

For more informaƟon order our: 
 

   FREE REPORT 
"The UlƟmate Guide to Choosing 
the RIGHT VoIP Phone System" 

 

 

 

 

 

 

 
Contact us at  

(201) 797‐5050 or 
www.tech4now.com/services/voip‐phones 

For Entertainment Purposes ONLY! 




